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About MDCStore Data Manager
Database Schema Installation 1

Introduction

This guide explains how to install the MDCStore™ High Content Data
Management Solution version 2.3 database schema for use with
Microsoft SQL Server and Oracle databases. It also explains how to
update an existing MDCStore database schema from version 2.0, 2.1,
or 2.2 to version 2.3.

CAUTION! The database-related information in this document is
provided for guidance only. Molecular Devices is not responsible for
damage to existing user data due to network problems, power failure,
or unexpected termination of the database. Molecular Devices is not
responsible for poor database performance due to an unoptimized
database environment. Molecular Devices strongly recommends that
you hire a database administrator (DBA) to set up, maintain, and
optimize the database for your installation. A DBA will monitor the
usage of your database configuration and can optimize the database for
best performance. For more information about database installation,
security, operation, and optimization, contact the appropriate software
vendor.

Product Compatibility

The MDCStore Data Manager version 2.3 database schema is
compatible with:

e Versions 2.0 or later of the MetaXpress® High Content Image
Acquisition and Analysis Software
e Version 1.0 or later of the MetaXpress® PowerCore™ High
Content Distributed Image Analysis Software
e Version 2.0 or later of the AcuityXpress™ High Content
Informatics Software
Version 5.1 of the MetaXpress Software requires version 2.3 of the
MDCStore Data Manager database schema.
Version 2.3 of the MDCStore Data Manager database schema is not

compatible with versions 1.6 and 1.7 of the MetaXpress Software or
version 1.0 of the AcuityXpress Software.

0112-0144 1



About MDCStore Data Manager Database Schema Installation

How to Obtain More Information

Additional information is available on the Web:
e For general information, go to
http://www.moleculardevices.com.

e To search the knowledge base, go to
http://www.moleculardevices.com/support.html.

Required Documents

Before you install the MDCStore Data Manager database schema, you
should review the information in the following documents:
e Molecular Devices High Content Screening Computer
Specifications
e Molecular Devices Complete Solution HCS IT Requirements

These documents are available in the knowledge base on the Molecular
Devices support site: http://www.moleculardevices.com/support.html.

How to Obtain Support

For technical support, see the Molecular Devices support site on the
Web at http://www.moleculardevices.com/support.html.

The knowledge base gives you access to support documentation and
software downloads as well as technical and troubleshooting
information. If you require personal technical support, you can submit a
service request form.

To speak to a Technical Support representative by phone, call 1-800-
635-5577 (toll free in the US) or 1-408-747-1700.
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Installing the MDCStore Data Manager
Database Schema for SQL Server 2

Introduction

This chapter explains how to install the MDCStore™ High Content Data
Management Solution version 2.3 database schema for Microsoft SQL
Server 2005 or Microsoft SQL Server 2012 databases. Throughout this

chapter, the Microsoft SQL Server database software is referred to as
SQL Server.

These instructions are for a fresh installation of the MDCStore Data
Manager database schema only. To update an existing installation of
the MDCStore Data Manager database schema, see Updating an
Existing MDCStore Data Manager Database Schema on page 43.

Note: If you have an Oracle database, do not use these instructions.
See Installing the MDCStore Data Manager Database Schema for
Oracle on page 15. To install Microsoft SQL Server 2012 Express, see
Installing SQL Server 2012 Express on page 49.

Topics in this section:
e Prerequisites on page 8
e Choosing the Appropriate Installer on page 9
e Creating User Accounts for the MDCStore Database on page 14

0112-0144 1



Installing the MDCStore Data Manager Database Schema for SQL Server

Prerequisites

Before you install the MDCStore Data Manager database schema, you
must set up a server and install the SQL Server database software.
Both the computer operating system and the database software must
be installed with U.S. English as the language setting. For instructions,
see the vendor’'s documentation.

Molecular Devices recommends that you use a dedicated server for the
MDCStore database. Using a server that hosts other databases or
applications might decrease performance.

Note: When installing and setting up a database on Windows 7, make
sure that you have logged into Windows 7 with full administrator
rights, and that you have full access to the folder where the database
is to be installed. Molecular Devices recommends that you set the User
Access Control (UAC) on the computer to the lowest security setting.

Required Documents
Before you install the MDCStore Data Manager database schema, you
should review the information in the following documents:

e Molecular Devices High Content Screening Computer
Specifications
e Molecular Devices Complete Solution HCS IT Requirements

These documents are available in the knowledge base on the Molecular
Devices support site: http://www.moleculardevices.com/support.html.

0112-01441
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Choosing the Appropriate Installer

The MDCStore Data Manager database schema installer is available on
the MetaXpress® Software Installation flash drive and also as a
standalone installer. If you are installing the software on a 64-bit
operating system, you can install either the 32-bit or 64-bit version of
each component. Molecular Devices recommends that you use the
64-bit version if you have a 64-bit operating system. If you are
installing the software on a 32-bit operating system, you can install
only the 32-bit version of each component.

e If you are installing from the MetaXpress Software Installation
flash drive, you can choose to install the appropriate 32-bit or
64-bit version. For complete instructions, see the MetaXpress
High Content Image Acquisition and Analysis Software Suite
Installation and Update Guide.

e If you are installing from a standalone installer, make sure that
you download the appropriate version of the MDCStore
installation package for your operating system (either 32-bit or
64-bit). Instructions for using the standalone installer are
included in this chapter. See Using the Standalone Installer on
page 9.

Using the Standalone Installer

To install the MDCStore Data Manager database schema from the
standalone installer

1. Log in to the computer where you want to install the MDCStore
Data Manager database schema.

If you are installing from the MetaXpress Software Installation
flash drive, see the MetaXpress High Content Image Acquisition
and Analysis Software Suite Installation and Update Guide.

2. Double-click the downloaded MDCStore archive file.
In the WinZip Self Extractor dialog, click Setup.
The system checks for prerequisites.

4. If required components are missing, a warning appears, and you
must click Install to install the components and continue.
Follow the installation instructions for any required components.

w
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Installing the MDCStore Data Manager Database Schema for SQL Server

When the prerequisite check is complete and all required
components are installed, the MDCStore Database Installer

Setup Wizard dialog appears.
‘_'@MDCStore Database Installer EI =] @

Molecular

Welcome to the MDCStore Database Installer UDeufces
Setup Wizard

The installer will guide you through the steps required to set up the MDCStore Databaze |nstaller on
your computer.

WARMIMG: This computer program is protected by copyright law and international treaties.
Unauthorized duplication or distribution of this program, or any portion of it, may result in severe civil
or criminal penalties, and will be progecuted to the maximum extent possible under the law.

5. Click Next and follow the on-screen instructions to set up the

MDCStore Data Manager database schema installer.

6. In the Confirm Installation dialog, click Next to start the

database installation.

10
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MDCStore Data Manager Schema Installation and Update Guide

During the installation, the Setup MDCSTORE dialog appears.
("1 Setup MDCSTORE S |

MDCStaore™
Software 2.3

Image Data Management Solution Desuirlan

[Databasze Scripts

For Research Use Only. Mot for use in disgnostic procedures.

Install SOL Express

Installsl)pgrade MDCStore

Explore the CD
Molecular

Devices B

7. Click Install\Upgrade MDCStore.

0112-0144 1 11



Installing the MDCStore Data Manager Database Schema for SQL Server

The Setup MDCSTORE message appears.

Setup MDCSTORE

This will install the MDC5tore 2.3 database schema on M5 SQL Server, or
l . upgrade an existing MDCStore 2.x schema on M5 SQL Server or
ORACLE.

To install the MDCStore 2.3 schema on ORACLE, you need to execute a
script located in the 'Scripts’ directory in the Installation folder on your
machine or on the Installer Media.

If you upgrade an existing database, make sure you have created a
database backup, before continuing with this process.

Once the database is upgraded, you may not be able to connect to the
database using older versions of AcuityXpress and MetaXpress software

(that may be compatible only with an clder version of the database).

Do you want to continue?

Yes | Mo |

8. Click Yes.
The Database Installation and Update dialog appears.

Database Installation and Update @

what do you want to do:

% Create a new databaze on this computer

ComputertSOL Instance: ||DVW|N?TESTD‘I \SQL_SEj
Mew database name: |MDESt0re |

~
Create
+ Create empty databasze

" Update an existing database

=

Databasze Wersion | Computer\SGL Instance

Update

| Cloze |

9. Select Create a new database on this computer, and then
provide the information required to create the database:

In the Computer\SQL Instance field, select the
appropriate instance, such as COMPUTERNAME\SQLSERVER.

*

12
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MDCStore Data Manager Schema Installation and Update Guide

+ In the New database name field, type a name for the new
database.

+ Click Create, and then specify a directory in which to install
the database.

+ Click Browse to select the directory.

Note: Molecular Devices recommends installing the database
on a computer with at least two separate partitions, storing the
database on the second partition (usually a separate hard drive
labeled as “D:") rather than the main partition with the
operating system and software. Storing the data on the hard
drive that doesn’t have the operating system and main
applications running increases performance and ensures that
your data will be accessible even if the operating system located
on the C drive is damaged or needs to be reinstalled. Molecular
Devices does not recommend using external hard drives as
these can be easily turned off and you will not have access to
the data. Do not install on a mapped or network drive for the
same reason.

10. Click OK to continue.

When the installation is successful, the following message
appears: The database has been installed successfully.

11. In the Installation Complete dialog, click Close, and then
click OK in the dialog that confirms the creation of the data
source.

The MDCStore Data Manager database schema is installed. To

set up user accounts for the MDCStore database, see Creating
User Accounts for the MDCStore Database on page 14.

0112-0144 1
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Installing the MDCStore Data Manager Database Schema for SQL Server

Creating User Accounts for the MDCStore Database

By default, there is a single user account for the SQL Server MDCStore
database: the sa (system administrator) account. If multiple users
need to access the database, log in using the sa account to create and
configure separate accounts for each user so that they do not need to
use the sa login.

To create user accounts for the MDCStore database, use the
MDCStoreTools Utility. See the MDCStoreTools Data Management Utility
User Guide included on the MetaXpress Software Installation flash
drive.

Note: The MDCStore database schema comes pre-installed on the
instrument workstation. For the MetaXpress Software version 4.0 and
above, the default User Login Name is MolDev, the default System
Administrator Login Name is sa, and the default password for both is
moldev. For versions of the software earlier than 4.0, the default User
Login Name and password was mdc. You might need to log in using
mdc if you had an earlier version of the software on your instrument
workstation.

For increased security, you can change the password for the system
administrator to something other than the default password shipped
with the system.

14
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Installing the MDCStore Data Manager
Database Schema for Oracle 3

Introduction

This chapter explains how to install the MDCStore™ High Content Data
Management Solution version 2.3 database schema for Oracle
databases. These instructions are for a fresh installation of the
MDCStore Data Manager database schema only. To update an existing
installation of the MDCStore Data Manager database schema, see

Updating an Existing MDCStore Data Manager Database Schema on
page 43.

Note: If you are using SQL Server do not use these instructions. See
Installing the MDCStore Data Manager Database Schema for SQL

Server on page 7. To use SQL Server Express, see Installing SQL
Server 2012 Express on page 49.

Topics in this section:
e Prerequisites on page 16

e About Installing the MDCStore Data Manager Database Schema
on Oracle on page 17

e Choosing the Appropriate Installer on page 17

e Using the Standalone Installer on page 18

e Creating Tablespaces and Configuring Users on page 20

e Creating User Accounts for the MDCStore Database on page 22

0112-0144 1 15



Installing the MDCStore Data Manager Database Schema for Oracle

Prerequisites

Before you install the MDCStore Data Manager database schema, you
must set up a server and install the Oracle database software. Both the
computer operating system and the database software must be
installed with U.S. English as the language setting. For instructions, see
the vendor’s documentation.

CAUTION! Oracle database names cannot contain spaces or special
characters. The names screening 1 and screening#2 are not valid
database names. The names screening_1 and screening_2 are valid
database names. Limit the characters used for the database names to
alphanumeric (0-9, a-z) and underscores (_).

Molecular Devices recommends that you use a dedicated server for the
MDCStore database. Using a server that hosts other databases or
applications might decrease performance.

Required Documents
Before you install the MDCStore Data Manager database schema, you
should review the information in the following documents:

e Molecular Devices High Content Screening Computer
Specifications
e Molecular Devices Complete Solution HCS IT Requirements

These documents are available in the knowledge base on the Molecular
Devices support site: http://www.moleculardevices.com/support.html.

16
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About Installing the MDCStore Data Manager
Database Schema on Oracle

There can be significant differences from one version of Oracle to
another, and these can affect the way the MDCStore Data Manager
database schema is installed and used. For example, Oracle 10g
introduced big tablespaces. These have not been tested and they are
not described in this document.

Keep these points in mind when installing the schema on Oracle:

e The MDCStore Data Manager database schema can be installed
on different partitions.

e There are no restrictions on creating global users in Oracle
through the MDCStore Data Manager version 2.3.
Administrators must choose a user creation policy that meets
their requirements.

Consult a database administrator for more information.

Choosing the Appropriate Installer

The MDCStore Data Manager database schema installer is available on
the MetaXpress® Software Installation flash drive and also as a
standalone installer. If you are installing the software on a 64-bit
operating system, you can install either the 32-bit or 64-bit version of
each component. Molecular Devices recommends that you use the
64-bit version if you have a 64-bit operating system. If you are
installing the software on a 32-bit operating system, you can install
only the 32-bit version of each component.

e If you are installing from the MetaXpress Software Installation
flash drive, you can choose to install the appropriate 32-bit or
64-bit version. For complete instructions, see the MetaXpress
High Content Image Acquisition and Analysis Software Suite
Installation and Update Guide.

e If you are installing from a standalone installer, make sure that
you download the appropriate version of the MDCStore
installation package for your operating system (either 32-bit or
64-bit). Instructions for using the standalone installer are
includeéj in this chapter. See Using the Standalone Installer on
page 18.

0112-0144 1 17



Installing the MDCStore Data Manager Database Schema for Oracle

Using the Standalone Installer

To install the MDCStore Data Manager database schema from the
standalone installer

1.

w N

Log in to the computer where you want to install the MDCStore
Data Manager database schema.

If you are installing from the MetaXpress Software Installation
flash drive, see the MetaXpress High Content Image Acquisition
and Analysis Software Suite Installation and Update Guide.

Double-click the downloaded MDCStore archive file.
In the WinZip Self Extractor dialog, click Setup.
The system checks for prerequisites.

If required components are missing, a warning appears, and you
must click Install to install the components and continue.
Follow the installation instructions for any required components.

When the prerequisite check is complete and all required
components are installed, the MDCStore Database Installer
Setup Wizard dialog appears.

‘_'@MDCStore Database Installer EI =] @

Molecular

Welcome to the MDCStore Database Installer @Devfces
Setup Wizard

The installer will guide you through the steps required to set up the MDCStore Databaze |nstaller on
your computer.

WARMIMG: This computer program is protected by copyright law and international treaties.
Unauthorized duplication or distribution of this program, or any portion of it, may result in severe civil
or criminal penalties, and will be progecuted to the maximum extent possible under the law.

Cancel < Back
Click Next and follow the on-screen instructions to set up the
MDCStore Data Manager database schema installer.

In the Confirm Installation dialog, click Next to start the
database installation.

18
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7. Click Database Scripts to find the location of the installation

During the installation, the Setup MDCSTORE dialog appears.

B Setup MDCSTORE

MDCStaore™
Software 2.3

Image Data Management Solution

For Research Use Only. Mot for use in disgnostic procedures.

Molecular
Devices

S

D ocumentation

[Databasze Scripts

Install SOL Express

Installsl)pgrade MDCStore

Explore the CD

Exit

scripts, and confirm that the scripts are present.

You must run the installer to this point to access the Oracle

installation scripts. However, do not continue using the installer

to complete the installation.

In the Setup MDCStore screen, click Exit.

Click Close.

To complete the installation, follow the instructions in Creating

Tablespaces and Configuring Users on page 20.

0112-0144 1
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Installing the MDCStore Data Manager Database Schema for Oracle

Creating Tablespaces and Configuring Users

To perform these tasks, you must connect to the Oracle server as user
SYS, connected as SYSDBA. This ensures that you can:

Create tablespaces

Create users

Create groups

Grant permissions on database objects
Create and drop in database objects

Molecular Devices recommends that you have the MDCStore database
schema created by a database administrator knowledgeable in Oracle.

CAUTION! The tablespace of the MDCStore database must be allowed
to expand past its initial size, since the database might grow
significantly. Molecular Devices recommends starting with 32 GB of
space and installing the database on a dedicated data partition, not on
the primary drive. Using external hard drives is not recommended since
they can be easily turned off, which prevents access to the data.

To create tablespaces and configure users

1. Open the SQL*Plus Worksheet, which is installed as part of
the Oracle client program.

2. Connect to the Oracle server as user SYS, connected as
SYSDBA. This requires that you change from the default or
Normal connection.

3. In the SQL*Plus Worksheet, run the following command to
create a tablespace for the MDCStore Data Manager database
schema.

Note: In the command, brackets (<>) indicate variables. You
must replace this text and the brackets with the appropriate
values. Do not type the brackets themselves. Quotation marks
that appear around text, however, are part of the command.

CREATE TABLESPACE "<your table space name>"
NOLOGGING

DATAFILE '<table space location>' SIZE <initial size of the
database (for example, 32000M)>

EXTENT MANAGEMENT LOCAL
SEGMENT SPACE MANAGEMENT AUTO;
COMMIT;

20
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Note: Using AutoExtend is not recommended. Calculate the
space requirements of the database based on the size of
experiments you plan to run, and then create additional data
files to allow the database to grow. You can approximate the
data storage space to be twice the amount of storage required
for images.

For the DATAFILE '<table space location>', use these
formats:

+ Windows:
C:\ORACLE\ORADATA\MDCStore1\MDCStore.ora

+ Linux/UNIX: C/opt/oracle/oradata/oral/MDCStore.dbf

CAUTION! The recommendations in this guide are for MDCStore Data
Manager database schema installation only. They are not intended to
provide guidelines for managing corporate databases. Some options
might not be appropriate for certain environments, and your database
administrator must determine whether 32 GB is a sufficient starting
point. Eventually, the tablespace requirements of the database might
increase.

. To create a global user to be used as the schema provider, run

this command:

CREATE USER <global user name> PROFILE "DEFAULT"
IDENTIFIED GLOBALLY AS "

DEFAULT TABLESPACE "<your table space name>"

TEMPORARY TABLESPACE "<your temporary table space
name>"

QUOTA UNLIMITED

ON "<your table space name here>"
ACCOUNT UNLOCK;

COMMIT;

GRANT "CONNECT" TO "<global user name>";

COMMIT;

. To change your current connection to the schema where you

want to install the MDCStore Data Manager database schema,
run this command:

ALTER SESSION SET CURRENT_SCHEMA = <global user
name>;

COMMIT;

0112-0144 1
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Installing the MDCStore Data Manager Database Schema for Oracle

6. To ensure the schema does not already contain data, run this
command:

select * from all_objects where owner = '<global user name>';
If there is no response, the schema contains no data.

CAUTION! If there is a response, the schema contains data, and that
data will be overwritten without warning when you run the installation
script in the next steps. To preserve existing data, use a new tablespace
and schema name when installing MDCStore Data Manager on Oracle.

7. In the SQL*Plus Worksheet, click File > Open and select the
appropriate Installation.sql file. To locate the .sql file, click
All Programs > MDCStore > MDCStore Database > Scripts
> MDCStore Install Script (Oracle).

8. Click Execute to create the database in the specified schema.

The MDCStore Data Manager database schema is installed. To
set up user accounts for the MDCStore database, see Creating
User Accounts for the MDCStore Database on page 22.

Creating User Accounts for the MDCStore Database

By default, there is a single user account for the MDCStore database:
the SYSTEM account. If multiple users need to access the database,
log in using the SYSTEM account and create and configure separate
Iaccounts for each user so that they do not need to use the SYSTEM
ogin.

To create user accounts for the MDCStore database, use the
MDCStoreTools™ Utility. See the MDCStoreTools Database Management

Utility User Guide included on the MetaXpress Software Installation
flash drive.
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Configuring the Database Client
Software 4

Introduction

To test the connection to the MDCStore™ database, you must install
and configure the Oracle or SQL Server database client software on a
client computer as described in this section.

Topics in this section:
e Prerequisites on page 23
e Information You Need on page 23
e Oracle Client Installation and Configuration on page 24
e SQL Client Configuration on page 37

Prerequisites

Before you begin, you must install and configure the MDCStore Data
Manager database schema for SQL Server or Oracle as described in the
following chapters:

e Installing the MDCStore Data Manager Database Schema for
SQL Server on page 7

e Installing the MDCStore Data Manager Database Schema for
Oracle on page 15

Note: When installing and setting up an Oracle database client on
Windows 7, make sure that you have logged into Windows 7 with full
administrator rights, and that you have full access to the folder where
the database is to be installed. Molecular Devices recommends that

you set the User Access Control (UAC) on the computer to the lowest
security setting.

Information You Need

When you configure the database clients, you need to know:

e The port number and other settings used by your MDCStore
database.

e Whether your operating system and database software are
32-bit or 64-bit. You must install the database client (32-bit or
64-bit) that matches your operating system.

0112-0144 1 23



Configuring the Database Client Software

Oracle Client Installation and Configuration

If you are using an Oracle database, you must install and configure
Oracle client drivers and services on all MDCStore clients as described
in this section.

Oracle installation and configuration tasks include:
e Installing and Configuring the Oracle Client on page 24
e Configuring the Oracle Net Service on page 31
e Configuring the Oracle ODBC Data Source on page 34

Installing and Configuring the Oracle Client

To install and configure the Oracle client
1. Log in to the client computer.

2. Download the appropriate Oracle database client drivers from
http://www.oracle.com/technology/software/products/database
/index.html.

CAUTION! You must install the appropriate version of the database
client to access the database. For example, if you have a 32-bit
operating system and you have installed the 32-bit version of the
MetaXpress® Software, you must use the 32-bit version of the
database client. You cannot use the 64-bit version of the database
client with the 32-bit version of the MetaXpress software to connect to
the database.

3. Unzip the downloaded package and double-click setup.exe to
start the installation.

24
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Welcome

The Oracle Univers

4. In the Welcome dialog, click Next.
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=] = =)

ORACLE 1

DATABASE

Select Installation Type
Oracle Client 11.1.0.7.0

What type of installation ¢
T Instantc

5. In the Select Installation Type dialog, click ustom.

6. If your system uses a language other than English (United
States), click Product Languages, and then select English
(United States). This ensures that the Oracle installers use
English (United States) regional and language settings, which
are required for the MDCStore Data Manager.

7. Click Next.
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DATABA 1gI

Install Location

Specify a hase location for stari
Oracle Base direc

Chappadminlser

QraClient!1g_hame1 "
ClappradminUsenproductil 1.1.0client_1

Install

8. In the Specify Home Details dialog, select the installation
location and then click Next.
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E Oracle Universal Installer: Product-Specific Prerequisite Checks

=

= || E2
ORACLE’

DATABASE 11g
Product-Specific Prerequisite Checks

The Installer verifies that your environment meets all of the minimum reguirements far installing and

canfiguring the products that you have chosen ta install. You must manually verify and confirm the items that
are flagged with warnings and items that require manual checks. For details about performing these
checks, click the iterm and review the details in the box at the bottorm of the window.

Check Type Status
Checking the Tength of PATH ervironment vanable... Autormatic Succeeded
Checking Oracle Home path far spaces.. Automatic Succeeded
Checking for Oracle Home incompatibilities .. Automatic Succeeded [+
4 »
Retry | | Stop

0 requirements to be verified.

Checking for Oracle Home incompatibilities ... o
Actual Result: MEW_HOME

Check complete. The overall result of this check is: Passed

Help Installed Products... Back et In=tall Cancel

9. Resolve any issues identified in the Product-Specific
Prerequisite Checks dialog, and then click Next.
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x Oracle Universal Installer: &vailable Product Components EI =] @

ORACLE 1 1g

DATABASE
Available Product Components
Oracle Client

The following are components that you can install as part of Oracle Client. YWhich of these components do you
want to install?

Components Install Status =l
5 B Oracle Windows Interfaces 11.1.0.7.0 ey Install
i oft Transaction Server 11.1.0.7.0 Mot Installed
Cracle Administration Azsistant for Windows 11.1.07.0 ot Installed
O Oracle Counters for Windows Performance Monitor 11.1.0.7.0 ot Installed L
Cracle ODEC Driver 11.1.0.7.0 ey Install
Cracle Pravider for CLEDE11.1.07.0 ey Install
Cracle Data Provider for NET 20111.07.0 ey Install
& Cwacla Drowidars for ASDRET 44 4 0.7 0 hlavas Imstall -
Expand All )I Collapse All )I Select All )I Deszelect All )I

[ Show all companents, including required dependencies.

Help )I InstalledEroducts...)l Back | et )I In=tall Cancel

10. In the Available Product Components dialog, select Oracle
Windows Interfaces, deselect Oracle Services for
Microsoft Transaction Server,

11. Ensure that the following check boxes are selected:
+ Oracle Administration Assistant for Windows
¢+ Oracle ODBC Driver
¢+ Oracle Net
+ SQL Plus
+ Oracle Connection Manager
12. Click Next.
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x Oracle Universal Installer: Surnmary EI =] @
ORACLE 11g
DATABASE
Summary

Oracle Client 11.1.0.7.0

—Oracle Glabalization Support11.1.0.7.0 =l
—Oracle Glabalization Support11.1.0.7.0

—Oracle Help For Java 4.2.9.0.0

—Oracle lce Browser 5.2.3.6.0

—Oracle JFC Extended Windowing Toolkit 4.2.36.0.0

—Oracle Locale Builder 11.1.0.7.0

—Oracle Met11.1.0.7.0

—0Oracle Met Required Support Files 11.1.0.7.0

—Oracle ODBEC Driver 11.1.0.7.0 | =
—Qracle ODBC Driverfor Instant Client 11.1.0.7.0

—Qracle One-Off Patch Installer 11.1.0.7.0

—Oracle Provider for OLE DB 11.1.0.7.0

—Oracle Providers for ASP.MET 11.1.0.7.0 =
1] | r

Help )I Installed Eroducts...)l Back [l et In=tall Cancel

13. In the Summary dialog, expand the New Installations section
to verify that the installation summary includes the correct
version of the ODBC driver, and then click Install.

14. Follow the on-screen instructions to complete the installation.
Do not configure any services during the installation if prompted
to do so.

The Oracle client software is installed.
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Configuring the Oracle Net Service
To configure the Oracle Net Service

1. On the MDCStore server or client, click Start > All Programs >
Oracle Client > Configuration and Migration Tools >
Net Manager.

;ﬁ Oracle Net Manager - ChapphAdminUseriproductilL L0client SNETWORKNVADMINY
Eile Edit Command Help

@—%gOraE\e Met Configuration

& Local

glﬂmﬂle

2. In the Oracle Net Manager window, select Service Naming,
and then click the green plus sign (+).

The Net Service Name wizard appears.

% Met Service Mame Wizard: Welcome @

To access an Oracle datahase, or other service, across the netwark
you use a net service name. This wizard will help you create a net

Service name.
/ Enter the name you want to use to access the database ar service.

It can he any name you choose.

Met Service Mame: ||

e
—
E

~ cancel |

Cancel . Back

3. In the Welcome dialog, in the Net Service Name field, type a
name for the service, and then click Next.
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Cancel

%47 MNet Service Mame Wizard, page 2 of 5: Pratacal @

To communicate with the database across a network, a netwark
protocol is used. Selectthe protocol used for the database you want to
access.

TCPIAP with S5L {Secure Internet Protocaol)
Mamed Pipes (Microsoft Metworking)
IPC iLocal Datahase)

4. In the Protocol dialog, select a protocol that is supported by

your system and by your Oracle database, and then click

Cancel

;’i Met Service Mame Wizard, page 3 of 5 Protocol Settings @

To communicate with the database using the TCRAP protocal, the
database computer's host name is required. Enter the TCPIIP host
name for the computer where the database is located.

Host Marme: MDCStoreHost

ATCPIP port numhber is also required. The port number for Oracle
databases is usually 1521, You should not narmally need to specify
a different port number.

Fort Mumber: 1521

Next.

5. In the Protocol Settings dialog, type the host nhame of the
server that hosts your Oracle database and the port number
that the database server listens to, and then click Next.

The default port for Oracle is 1521.

32

0112-01441



MDCStore Data Manager Schema Installation and Update Guide

w Met Service Mame Wizard, page 4 of 5: Service
pag

To identify the database or service you must provide either its service
name, far Oracledi 8.1 or later, or system identifer (5109, for Oracled
8.0 database versions. The service name for an Oracle8i or later
database is normally its glohal database name.

® (Craclefior later) Service Mame: ||

" {Oracle® or Previous) SID: |ORCL

Optionally, you can choose if you want a shared, dedicated or pooled
server database connection. The default is to let the database
decide.

Connection Type: |Database Default hd

Cancel & Back

6. In the Service dialog, type the service name that is used by the
Oracle database you are connecting to, or provide the system
identifier, and then click Next.

w Met Service Mame Wizard, page 5 of 5: Test
pag

FPress Testif you would like to verify that the databasze can he
reached using the information provided.

When yau are finished, or if you want to skip testing, press Finish
to create the net service name or, if enabled, Mext to caontinue.

Test.

Cancel & Back [+t

7. Click Test to verify your settings.

If the configuration is complete, a confirmation message
appears.

If a problem is detected, change your connection settings and
try again.
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Configuring the Oracle ODBC Data Source

32-bit applications can use only data sources configured with a 32-bit
ODBC driver and 64-bit applications can use only data sources
configured with a 64-bit ODBC driver.

Molecular Devices recommends that you configure new data sources
using the New Data Source button on the dialog that appears when you
start the MetaXpress Software. For instructions, see “"Set Up the
MetaXpress Software” in the MetaXpress Software Installation Guide
included on the MetaXpress Software Installation flash drive.

If you do not have MetaXpress Software or AcuityXpress Software
installed on the client computer, you can configure the ODBC data
source using the Administrative Tools section of the Windows Control
Panel as described in the following procedure.

Note: If your client computer is running Microsoft Windows 7 or Vista,
and if the User Access Control (UAC) is enabled, you must log in using
the main Administrator account, not the local Administrator account,

to create a data source. To access UAC, go to Control Panel > User
Accounts.

To configure the Oracle ODBC data source using
Control Panel

You can use this procedure to configure a 32-bit data source on a 32-bit
operating system, or a 64-bit data source on a 64-bit operating system.

Note: Do not use this procedure if you have MetaXpress Software or
AcuityXpress Software installed on the client computer. Molecular
Devices recommends that you configure new data sources by clicking
the New Data Source button on the dialog that appears when you start
the MetaXpress Software. For instructions, see “Set Up the
MetaXpress Software” in the MetaXpress Software Installation Guide
included on the MetaXpress Software Installation flash drive.

1. On the client computer, go to the Administrative Tools section
of the Windows Control Panel.

2. in the Administrative Tools list, double-click Data Sources
(ODBC), and then click the System DSN tab.
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;‘ QODBC Data Source Adrministrator @

User DSM | Swstem DSH | File DSM I Dirivers I Tracing I Connection Pooling I About |

System Data Sources:

Mame  DCriver Add...

Remove

Configure. ..

An DDBC Systemn data source stores information about how to connect to
m the indicated data provider. A System data source iz vizible to all uzers
on thiz machine, including MT services.

[ QK J [ Cancel Apply

3. Click Add.

Create Mew Data Source @

Select a driver for which you want to et up a data source.

Mame Wergion Comg

i Oracle in OraClient11g_home2 ERORTINE Oracl
i} E

4 I 2

< Back [ Finizh J[ Cancel ]

4. In the Create New Data Source dialog, select the Oracle
driver provided by Oracle Corporation.

5. Click Finish.
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The Oracle ODBC Driver Configuration property sheet

appears.

Oracle ODBC Driver Configuration

[rata Source Mame MDCSTORE_ORACLE

Description
TMS Service Name MDCStore
Uszer D system

Application | Oracle I ‘whorkarounds I SOLServer Migrati0n|

.
Test Connection

Enable Result Sets

Enable Closing Cursors [ Enable Thread Safety

Enable Query Timeout Read-Only Connection [

Batch Autocommit Mode [ Commit only if all statements succeed

7

Mumeric Settings [Use Oracle MLS settings

7

——

| Application| Oracle |W’0rkar0unds I SOLServer Migrati0n|

Failover

——

Bind TIMESTAMP as DATE

Force SOL_WCHAR Support

O
Dizable Microsoft Tranzaction Server
O

Fetch Buffer Size Enable Failover
Enable LOBEs Rty 10
Erable Statement Caching [—] Delay 10
Cache Buffer Size 20
Application | Oracle | Workarounds | SOLServer Migration

[} Dizable SQLDescrbeParam

Set Metadata Id Default ta SOL_TRUE

Bind NUMBER Az FLOAT

Disable RULE Hint

o O

——

Application I Oracle I Workarounds| SOLServer Migration

Enable EXEC Syntax  []

Schema
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6. In the Data Source Name field, type the name of your data
SOtércle. This name must be the same for all MDCStore servers
and clients.

7. In the TNS Service Name field, select a name from the list.
The TSN Name must match the name of the service that is set
up in the Oracle Net Manager.

8. In the User ID field, type the ID of a user account that has
access to the MDCStore database.

9. Click Test Connection.

If the connection test is successful, data source configuration is
complete. If a problem is detected, change your connection
settings and try again.

SQL Client Configuration

If you are using the SQL Server database, you can configure the SQL
client on the MDCStore clients as described in this section.

Configuring the SQL Client

32-bit applications can use only data sources configured with a 32-bit
ODBC driver and 64-bit applications can use only data sources
configured with a 64-bit ODBC driver.

Molecular Devices recommends that you configure new data sources by
clicking the New Data Source button on the dialog that appears when
you start the MetaXpress Software. For instructions, see “Setting Up
the MetaXpress Software” in the MetaXpress Software Installation
Guide included on the MetaXpress Software Installation flash drive.

If you do not have MetaXpress Software or AcuityXpress Software
installed on the client computer, you can configure the ODBC data
source using the Administrative Tools section of the Windows Control
Panel as described in the following procedure.
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To configure the SQL client using Control Panel

Note: Do not use this procedure if you have MetaXpress Software or
AcuityXpress Software installed on the client computer. Molecular
Devices recommends that you configure new data sources by clicking
the New Data Source button on the dialog that appears when you start
the MetaXpress Software. For instructions, see “Setting Up the
MetaXpress Software” in the MetaXpress Software Installation Guide
included on the MetaXpress Software Installation flash drive.

1. Log in to the client computer.
2. Go to the Administrative Tools section of the Windows Control
Panel.
3. Double-click Data Sources (ODBC), and then click the System
DSN tab.
3. QODBC Data Source Adrministrator @

User DSM | Swstem DSH | File DSM I Dirivers I Tracing I Connection Pooling I About |

System Data Sources:

Mame  DCriver Add...
Remove

Configure. ..

An DDBC Systemn data source stores information about how to connect to
the indicated data provider. A System data source iz vizible to all uzers
on thiz machine, including MT services.

[ QK ] [ Cancel Apply

4. Click Add.
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Create Mew Data Source @

Select a driver for which you want to et up a data source.

Mame Wergion Company
S0L Mative Client 2005.90.1393.00  Microsoft Corporat,

=10 & E.01.7600.16385  Microsoft Corporat,

< Back [ Finizh ][ Cancel ]

5. In the Create New Data Source dialog, select SQL Server or
SQL Native Client, and then click Finish.

Create a Mew Data Source to SOL Server @

Thiz wizard will help you create an ODBC data source that you can use to
connect to SAL Server.

a' ‘what name do you want to use to refer to the data source?
)‘l Mame:  MDCStore
1

How do you want to describe the data source?

Deseription:  MOCStore Database

‘wihich SOL Server do you want to connect to?

Server  [local) -

[ Finizh ][ Mext » ][ Cancel ] [ Help ]

6. In the first dialog of the Create a New Data Source to SQL
Server wizard, type the name and description of the SQL Server
dlatﬁ source, select the server you want to connect to, and then
click Next.

Note: To connect to a local instance of SQL Server, choose the
server from the list. If you do not see the local server listed try
using (local)\Instance [for example, (local)\SQLEXPRESS].
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Create a Mew Data Source to SOL Server @

How should SGL Server verify the authenticity of the login 107

;' @ 'With Windows NT authentication using the network login 1D
/_l ‘wiith SOL Server authentication uzing a login 1D and password
e L = entered by the user.

To change the network: library uzed to communicate with SOL Server,
click Client Configuration.

Client Configuration. ..

Connect to SGL Server to obtain default settings for the
additional configuration options.

Adminl ser

I < Back ” Mext » ]l Cancel II Help I

7. In the second dialog of the wizard, provide authentication

8.

information, and then click Next.

Create a Mew Data Source to SOL Server @

Change the default database to:
[Default) -

E‘ . [] Arach database filenarne:
2
1

m Create temporary stored procedures for prepared SOL statements and
drop the stored procedures:

Only when vou dizconnect.
Wwhen vou dizconnect and as appropriate while you are
cohnected.

Usze AMS| quoted identifiers.
Use ANSI nulls, paddings and warmings.

m Use the failover SOL Server if the primary SOL Server iz not
available.

I < Back ” Mext » ]l Cancel II Help I

In the third dialog of the wizard, select the Change the default
database to check box and choose the database you are using

as the MDCStore database.

9. Select the Use ANSI quoted identifiers and Use ANSI nulls,
paddings and warnings check boxes, and then click Next.
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Create a Mew Data Source to SOL Server @

[] Change the language of SOL Server system messages to:

= (Default
}I.l [ Use strong encryption for data

e} i
Perfarm translation for character data

Uze regional settings when outputting currency, numbers, dates and
O time:s.

[ Save long running queries to the log file:
LA zersbADMINU T4 ppDatatLocal\ T emphOUEF Browse...
Long query time [milizeconds): | 2n000

[ Log ODEC driver statistics to the log file:
CAUzershADMINU~1\AppD atatLocalh TemphSTAT Browse...

[ < Back ][ Finizh ][ Cancel ] [ Help ]

10. Select the Perform translation for character data check box.

11. Clear the Use regional settings when outputting currency,
numbers, dates, and times check box, and then click Finish.

12. In the final dialog of the wizard, test your data source

connection by clicking Test data source and then following the

on-screen instructions.
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Updating an Existing MDCStore
Data Manager Database Schema 5

Introduction

This section explains how to update the MDCStore™ Data Manager
database schema from version 2.0 or above to version 2.3.

Topics in this section:
e Prerequisites on page 43
e Choosing the Appropriate Installer on page 44

e Updating from Version 2.0 or Above to Version 2.3 Using the
Standalone Installer on page 45

Prerequisites

Before you update the MDCStore Data Manager database schema,
verify that the current version is version 2.0 or later. If you have an
earlier version of the MDCStore Data Manager database schema, you
must update to at least version 2.0 before you can update to version
2.3. For instructions, see the MDCStore 2.0 installation guide, which is
included on the MetaXpress® Software and AcuityXpress™ Software
version 2.0 CDs.

In addition, Molecular Devices highly recommends that you back up
your database before you update the schema.

CAUTION! Molecular Devices is not responsible for damage to existing
user data that could happen due to network problems, power failure,
unexpected termination of the update process or customization of the
existing MDCStore database. You should make a full backup of the
database before beginning the update.

Required Documents
Before you install the MDCStore Data Manager database schema, you
should review the information in the following documents:

e Molecular Devices High Content Screening Computer
Specifications

e Molecular Devices Complete Solution HCS IT Requirements

These documents are available in the knowledge base on the Molecular
Devices support site: http://www.moleculardevices.com/support.html
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Choosing the Appropriate Installer

The MDCStore Data Manager database schema installer is available on
the MetaXpress® Software Installation flash drive and also as a
standalone installer. If you are installing the software on a 64-bit
operating system, you can install either the 32-bit or 64-bit version of
each component. Molecular Devices recommends that you use the
64-bit version if you have a 64-bit operating system. If you are
installing the software on a 32-bit operating system, you can install
only the 32-bit version of each component.

e If you are installing from the MetaXpress Software Installation
flash drive, you can choose to install the appropriate 32-bit or
64-bit version. For complete instructions, see the MetaXpress
High Content Image Acquisition and Analysis Software Suite
Installation and Update Guide.

e If you are installing from a standalone installer, make sure that
you download the appropriate version of the MDCStore
installation package for your operating system (either 32-bit or
64-bit). Instructions for using the standalone installer are
included in this chapter. See Updating from Version 2.0 or Above
to Version 2.3 Using the Standalone Installer on page 45.

44
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Updating from Version 2.0 or Above to Version 2.3
Using the Standalone Installer

To update the MDCStore Data Manager database schema from the
standalone installer

1.

N

5.

Log in to the computer where you want to install the MDCStore
Data Manager database schema.

+ For SQL, use sa as the login name.
+ For Oracle, use system as the login name.

If you are installing from the MetaXpress Software Installation
flash drive, see the MetaXpress High Content Image Acquisition
and Analysis Software Suite Installation and Update Guide.

Double-click the downloaded MDCStore archive file.
In the WinZip Self Extractor dialog, click Setup.
The system checks for prerequisites.

If required components are missing, a warning appears, and you
must click Install to install the components and continue.
Follow the installation instructions for any required components.

When the prerequisite check is complete and all required
components are installed, the MDCStore Database Installer
Setup Wizard dialog appears.

‘_'@MDCStore Database Installer EI =] @

Molecular

Welcome to the MDCStore Database Installer @Devfces
Setup Wizard

The installer will guide you through the steps required to set up the MDCStore Databaze |nstaller on
your computer.

WARMIMG: This computer program is protected by copyright law and international treaties.
Unauthorized duplication or distribution of this program, or any portion of it, may result in severe civil
or criminal penalties, and will be progecuted to the maximum extent possible under the law.

Cancel < Back

Click Next and follow the on-screen instructions to set up the
MDCStore Data Manager database schema installer.
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6. In the Confirm Installation dialog, click Next to start the

database installation.

During the installation, the Setup MDCSTORE dialog appears.

B Setup MDCSTORE

MDCStaore™
Software 2.3

S

Image Data Management Solution

D ocumentation

[Databasze Scripts

For Research Use Only. Mot for use in disgnostic procedures.

Install SOL Express

Molecular

Installsl)pgrade MDCStore

Explore the CD

Devices

Exit

7. Click Install\Upgrade MDCStore.
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The Setup MDCSTORE message appears.

r Y
Setup MDCSTORE l-"“"-l

This will install the MDC5tore 2.3 database schema on M5 SQL Server, or
JA upgrade an existing MDCStore 2.x schema on M5 SQL Server or
ORACLE.

To install the MDCStore 2.3 schema on ORACLE, you need to execute a
script located in the 'Scripts’ directory in the Installation folder on your
machine or on the Installer Media.

If you upgrade an existing database, make sure you have created a
database backup, before continuing with this process.

Once the database is upgraded, you may not be able to connect to the
database using older versions of AcuityXpress and MetaXpress software

(that may be compatible only with an clder version of the database).

Do you want to continue?

8. élick Yes.
The Database Installation and Update dialog appears.

Database Installation and Update

what do you want to do:

—(" Create a new database on this computer

CormputersSOL Instance: IlDVWlN?TESTD‘I \SQL_SELI
Mew database name: IMDEStore

" Create database containing demo data
Create |
& Create empty database

& Update an exizting databaze

' pdate a database on this computer

Databasze | ‘Wersion | ComputersSAL Instance

MOCStare 1] IDVAWINFTESTOT
I

'l 1 | +

" Update a databaze on the network

Update |

or | cese |
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10.

11.

12,

13.

In the Update an existing database section, choose one of
the following options:

+ To update the SQL Server database on the server you are
logged into, select Update database on this computer,
select the database you want to update, and then click
Update.

+ To update an Oracle database, or to update the SQL Server
database on a different server, click Update a database on
the network, and then click Update.

Read the warning information, and then click OK to
acknowledge that you are ready to update the database.

If you are updating the SQL Server database on the server itself,
type the user name and password required to access the
database, and then click OK.

If you are updating an Oracle database, or the SQL Server
database on the network, select the data source you want to
connect to, type the login name and password of an account
with database administrator privileges (for example, sa or
system), and then click OK.

For Oracle databases, select the database schema you want to
update, and then click OK.

When the update is complete, a message appears stating that
the database has been updated successfully.
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Introduction

This appendix explains how to install Microsoft SQL Server 2012
Express, which is referred to as SQL Express throughout this appendix.
SQL Express is useful for demonstration or evaluation purposes.
However, the SQL Express database is limited to 10 GB in size, so it is
impractical for production environments.

Microsoft SQL Server 2012 Express is included on the MetaXpress
Software Installation flash drive and can be installed using the following
procedures.

Note: Molecular Devices recommends that you do not install SQL
Express if either SQL Server 2005 or SQL Server 2012 is already
installed.

Topics in this appendix:
e Accessing the SQL Express Installer on page 49
e Enabling Named Pipes and TCP/IP Connections on page 50

Accessing the SQL Express Installer

Microsoft SQL Server 2012 Express is included on the MetaXpress
Software Installation flash drive. It can be installed by following
procedure in the MetaXpress High Content Image Acquisition and
Analysis Software Suite Installation and Update Guide, which is
provided on the MetaXpress Software Installation flash drive and is
available in the Molecular Devices knowledge base at
http://www.moleculardevices.com/support.html.

After installing SQL Express, you must enable named pipes and TCP/IP
connections and ensure that the SQL Browser service is running so that
remote users can connect to this instance of SQL Server Express. See
Enabling Named Pipes and TCP/IP Connections on page 50.
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Enabling Named Pipes and TCP/IP Connections

1. Click Start > All Programs > Microsoft SQL Server 2012 >
Configuration Tools > SQL Server Configuration Manager.

Note: You will also see a listing for Microsoft SQL Server 2008.

These are support files that are needed for SQL Server Express
2012.

“§8 SQL Server Configuration Manager (Local) || Name State Start Mode Log On As Process ID

[ SQL Server Services
+ 4. SQL Server Network Configuration
» 2 SQL Native Client 11.0 Configuration

I85QL Server Browser Running Other (Boot, Syste..  NT AUTHORITAALO... 0
) SQL Server (SQLEXPRESS) Running Automatic NT Service\MSSQL.. 2900
[85QL Server Agent (SQLEXPRESS) Stopped Other (Boot, Syste..  NT AUTHORITYNE... 0

B

2. In the left pane of the Sql Server Configuration Manager,
expand SQL Server Network Configuration, and then select
Protocols for SQLEXPRESS.
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& SQL Serve anager (Local) || protocol ctaten
i sl K Cont ¥ Shared Memory  Enabled
. P = sqLExPRgEss ' ¥ Named Pipes Disabled

or
, & SQLNetive Client 11.0 Configuration || ¥ 1C"/F Dissbled

3. In the right pane of the Sql Server Configuration Manager,
right-click Named Pipes, and then click Enable.

4. In the right pane of the Sql Server Configuration Manager,
right-click TCP/IP, and then click Enable.

5. Close the SQL Server Installation Center dialog.

Note: If you have Windows Firewall running on your server
computer, then you must add the Microsoft SQL Server service
(sqlsvr.exe) and the Microsoft SQL Browser service
(sqlbrowser.exe) to the firewall Exceptions list so that remote
connections to the database are possible. For assistance,
contact your system administrator.
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